Cours pratique de télédétection :
méthodes et techniques de traitement
d'images satellitales a partir du
logiciel ENVI

Ce cours est destiné aux ¢€tudiants souhaitant acquérir les bases du traitement
d’images satellitales a partir du logiciel ENVI 4.1. A la fin de cet enseignement,

les étudiants sont capables de réaliser :

— la visualisation des données de télédétection ;
— I’extraction de I’information spatiale ;

— P’extraction de I’information spectrale ;

— les classifications ;

— la détection des changements.



1. Utilisation d’un fichier image dans ENVI 4.1

1.1 Ouverture d’un fichier image et réalisation d’'une composition colorée

1.1.1 Ouverture d’'une image

Pour ouvrir un fichier image, au format ENVI (.hdr) dans ENVI, il faut suivre les étapes suivantes
- Programme - RSI ENVI 4.1

La fenétre ENVI apparait sur le bureau.

- Sélectionner le menu « File » - « Open Image file » > « ouvrir » >

SRR ==

File| BasicTools _Classification Transform _Filter Spectral Map Vector Topographic Radar  Window Help

Open Image File
Open Vector File

Open External File »

Open Previous File >

Edit ENVI Header

Grecte Tt Dute Enter Data Filenames =
———

i () [+ teledetection armes + <[4 || Rechercher r

Save File As » -

Import from IDL Variable
Export to IDL Variable

Compile DL Module [E| Documents
IDL CPU Parameters

Date de modification  Type Taille

. 0507

e | 0607
% Emplacements réce...
0807

Tape Utilities , M Bureau | classification 0707
Scan Directory List B Ormates découp tassel cap indice 0407
Change Output Directory Bl Images seuillage 0107

B Musique | Landsat_Bouregreg_2006

Save Session to Script

P (5 Modifié récemment | || Landsat_Bouregreg 2006.hdr
ecute Startup Script
e ‘pG P B Recherches [ rassemblement des couleurs
estore Displa; rou,
i | Public || rassemblement des couleurs.hdr
ENVI Queue Manager
ENVI Log Manager Dossiers ~
Close Al Files Nom du fichier : Landsat_Bouregreg_2006 hr [ B —
Exit L C

Choisissez I’extension « .hdr » correspondant & votre image. Comme le montre I’image si dessous.

Dans cet exemple, on a choisi le fichier Landsat_bouregreg 2006.hdr.

La boite de dialogue « Available Bands List » affiche le nombre des couches que constituent 1’extrait de 1’'image
Landsat_Bouregreg 2006 . Les 6 bandes de I'image Landsat apparaissent.

Les longueurs d’ondes correspondantes sont donc : I [ Zonilable B T

. Fil Options
Bande 1 : Le domaine du Bleu. S
El-figl Landsat_Bouregreg_2006
Bande 2 . Le domaine du vert i o0 Mask (Mask (Band 1:Landsat_bouregreg_2006_

O Mask (Mask (Band 2:Landsat_bouregreg_2006_
Bande 3 : Le domaine du Rouge o Mask (Mask {Band 3:Landsat_bouregreg_2006_

O Mask (Mask (Band 4:Landsat_bouregreg_2006_
o Mask {Mask (Band 5:Landsat_bouregreg_2006_
O Mask (Mask (BEand &6:Landsat_bouregreg_2006_

Map Info

Bande 4 : Le domaine du Proche Infrarouge (PIR
Bande 5 : Le domaine du Moyen Infrarouge (MIR)
Bande 6 : Le domaine du Thermique.

4 | [l | k

* Gray Scale  RGE Color

Selected Band
|Mask (Mask (Band 3:Landsat_bouregreg_2006_b1-5_b7):L

| Dims [B321 x 7281 (Byte) [BSQ] |

| Load Band |ll1|h|h'V||

Dans ENVI il y’a deux modes de visualisation de I’image : Gray Scale (échelle de gris) et RGB (rouge, vert
et bleu). L’image résultante de ce dernier mode d’affichage est dite composition colorée.




1.1.2 Affichage en gray scale

Cliquez sur une des bandes de ’image et choisissez le mode d’affichage Gray Scale — puis ¢ liquez sur le bouton «
Load Band ».(comme le montre I’image ci-dessous).

@] EnvIAL [S[E[ =]
[ File Basic Tools Classification Transform _Filter al Map Vector Topographic Radar Window Help |
— ———————————
71 Mask (Mask (Band 3Landest bov 75006 b, | o |=D|ee| \
a =29 %] Availabie Bands Lt ) L0 L= IRESH]
File Overloy Enhance Tools Window
i = File Options

E-figl Landsal_Bouregreg_2006
O Mask (Mask (Band 1:Landsat_bou
© Mask (Mask (Band 2 Landsat_bou
o Mask (Mask (Band 3 Landsat_bou
----- o Mask (Mask (Band 4 Landsat_bou
Mask (Mask (Band 5:Landsat_bou
Mask (Mask (Band 6:Landszt_bou
p Info

< i | 3

% Gray Scale " RGE Color

Selected Band
[Mask (Mask (Band 3:Landsat_bouregreg_20(

|D1ms 8321 x 7381 (Byte) [BSQ] |
Load Band | Diesplay 81~/

1.1.3 Composition colorée d’'une image

Sur la fenétre available bands list > RGB=> R :B4 - G : B3 © B : B2 2>load RGB
L’image s’affiche dans 3 fenétres :

- une partie de la scene entiere (Image),
- une fenétre Scroll permettant de sélectionner la sous-scéne a afficher,
- une fenétre Zoom permettant de visualiser une zone donnée de I’image.

&) envia1 o | &
[ File Basic Tools  Classification Transform Filter Spectral Map Vector Topographic Radar Window Help |

] Available Bands Lt = [ =1 B8]

= = = =G
#1 (RMask (Mask (Band A-andsat Bouregreg, 2006... || =H £
File  Options

File Overlay Enhance Tools W

= ) Landsat_Bouregreg_2006.
i Mask (Mask (Band 1:Landsat_bou
o Mask (Mask (Band 2 Landsat_bou
i Mask (Mask (Band 3 Landsat_bou
i+ 0 Mask (Mask (Band 4 Landsat_bou
O Mask (Mask (Band 5Landsat_bou
o Mask (Mask (Band 6:Landsat_bou
p Irfo

© GraySede (& RGE Color

& R [Mask Mask (Band 4 Landsat_bour
¢ G [Vesk Mask Band 3Landsat_bour
g [Mask (Maskc (Band ZLandset_bour

Dims [8321 7381 (Byte} [B5Q]
Load AGE | Digalay 1~




1.2 Extraction d’une partie de I'image
Objectif :
L’objectif de cette application est de délimiter une zone d’étude ou d’extraire une partie sur d’une

scene entiére.

1.2.1 Exemple de I'’extraction d’'une partie du Bassin versant du Bouregreg

Sur la barre du menu ENVI sélectionner
Tools > reseize data (spatial/spectral) > Choisir ’image et mettre Ok —> Spatial subset > Image

La fenétre correspondant a I’image « Resize Data input file » s’affiche.

) ENvI 41 (=[E] = |
|Fi|E Basic Tools Classification  Transform  Filter Spectral Map Vector Topographic  Radar  Window Help |

Select Input File: File Information:
File: C:\Usershllham*Desltop'teledetection amas'L:
Dims: 8321 x 7381 x 6 [BSQ]
Size: [Byte] 368,503,806 bytes.

File Type : ENVI Standard
Sensor Type: Unknown
Byte Order : Host (intel)
Projection : UTM, Zone 30 Morth
Picel : 30 Meters
Datum  : WGS-84
Wavelength : None
Upper Left Comer: 1,1
Description: Applied Mask Result
[Wed Jan 12 14:54:46 2011]

| Spatial Subset fFLI"SCEnE— HSeIect By |File J,I.”
| Spectral Subset ||6/6 Bands |

| 0K | Cancel || revious |||ChmV‘|

Pour pouvoir découper une partie de I’image il faut cliquer sur « Spatial Subset », la fenétre « select spatial Subset
» s’affiche,

£] Select Spatial Subset

File: Landsat_Boursareg_2006
Dims: 8321 x 7381 (Byte)

Samples |1 To|8321  Ns|8321
Lines |1 To|7381  NL(7381

Full Size : 61,417,301 bytes
Subset Size: 61.417.301 bytes

Subset Using
image | Map | Fie | \ \

Subset by Image Input Band [1 &1

oK Cancel

11 faut choisir ’image en cliquant sur « image »

Déplacer le carré rouge sur la partie d’étude pour la découper.

Dessiner le carré sur I’image et mettre OK sur les fenétres « Subset by image », « select
spatial Subset » et « Resize Data input file » > File ou memory.

Samples [2665 4l Lines[1755 &
0K | Cancel




1.2.2 Les modes d’enregistrements

a. Enregistrement instantané : « memory »

Pour un enregistrement instantané, le

temps de travailler sur ENVI. Dés la fermeture du logiciel, vous ne pouvez

pas récupérez les fichiers enregistrés en mode memory.

Pour ce mode il suffit au moment de cliquer sur « memory » = OK

{H] Resize Data Parameters =]

Output File Dimensions:

Samples | 2665 «fac |1.000000
Lines |1755 yfac |1.000000

Set Output Dims by Pl Size \
Output Size: 28,062,450 bytes

Resampling:  Nearest Neighbor
Outpt et Fie

OK Queue | Cancel

b. Enregistrement sur le poste de travail : mode « file »

Ce mode d’enregistrement permet de

garder les fichiers enregistrés sur le poste de travail.

Pour le faire, choisissez « File » cliquer apres sur « choose » pour choisir I’emplacement du fichier = choisissez un
dossier pour enregistrer le fichier et donnez-lui un Nom comme le montre 1’image suivante.

Nom " Date de modificatio

[El Documents

i i examples
% Emplacements réce...
external
M Bureau help
gl s Ordinateur o
B mages products
B Musique resource
@ Modifié écemment | @] relnotes
Recherches | relnotes.
Public
Dossiers ~

@ Resize Data Parameters \il“

Qutput File Dimensions:

— Samples |2665 «fac |1.000000
n  Type Taille b Lines |1755 yfac |1.000000

Set Output Dims by Pore Sizs... |
COutput Size: 28,062, 450 bytes

Resampling:  MNearest Neighbor

Output Result to &+ File |  Memory
Enter Output Filename Choose | [T Compress

|C:"-.RS INDLET découpage

Nom i ichier: T

BlE -]

0K Queue | Cancel

. o

Terminer I’enregistrement sur le poste en mettant « ouvrir » = OK sur la fenétre « reseize data parameters »

Votre nouveau fichier sera directement enregistré dans le dossier que vous avez choisi et ’image et il apparaitra sur

la fenétre « available bands list ».

2. Connaitre les Signatures spectrales des objets sur une image

Objectif : Le but de ce module est de reconnaitre les signatures spectrales des différents type d’occupation du :

sols nus, cultures, eau, foréts, ....

File Basic Tools _Classification Transform _Filter _Spectral Map Vector Topographic _Radar Window _Help |J

£i] Available Bands List ElEsE]

Link Displays.

File Options

£ découpage B Menu

< [

Geographic Link.  Gray Scale = RGE Color

o

s ﬁ:itiﬂ:itii:::;tif . .
s s o g 41 Bouton droit de la souris > Z Profile (spectrum)
Resize (Mask (Mask (Band 5:|
Resize (Mask (Mask (Band 6:L|

e e ame La fenétre Spectral profil s’affiche.

o Mask (Mask (Band 1:Landsat_
o Mask (Mask (Band Z:Landsat_ ~

v

Z Profile (Spectrum)...
ROI Tool

Interactive Stretching

Save Image As..

Save Zoom As..

= s [Fosoe O Ok G En déplagant le curseur de la souris on apergoit que la
o [Feme ek i B 3o signature spectrale change selon le couvert végétal de la
50 [EEEXERaeey zone comme le montre la figure ci-dessous.

Pixel Locator...

Toggle »

Cursor Location/Value. Dims 2665 x 1755 (Byte) [BSQ]
Load RGE | Dicplay #1~/

Display Window Style »

Scroll/Zoom Position

<Find Display>




] #1 (ReResize (Mask (Mask (Band Tilandsat bouregre.. 3| G| 58|

Zone de forét

3. Histogramme bidimensionnel

3.1 Histogramme bidimensionnel

] #1 (RResize (Mask (Mask (i atbouregre., ResHER ]

File

SIS

] #1 Spectral ProfileMemory1]
File Edit

I 3
Band Number

Zone d’eau

Objectif : ce module permet de voir la distribution des pixels de 1’image sur un plan bidimensionnel (X et Y).

En choisissant, par exemple, en axe des abscisses (X) la bande 4 correspondant au PIR et en axe des coordonnées (Y)
la bande 3 correspondant au Rouge, on peut avoir une identifier les objets géographiques en fonction de leurs positions
relatives dans le plan X.

—_—
Zi] #1 (RiResize (Mask (Mask (Band 4iLandsat bouregre._
File Overlay Enhance Window

Link

Profiles

o=

Polarization Signatures

Region Of Interest

Color Mapping

Cursor Location/Value...

Pixel Locator...

Paoint Collection...
Build Mask...

Measurement Tool...

Line of Sight Calculator...

Spatial Pixel Editor...

Spectral Pixel Editor...

Animation...

2D Scatter Plots...

3D SurfaceView...

4] Scatter Plot Band Choice

Choose Band X:

Choose Band :

=il Memory 1]

“- 0 Resize (Mask (Mask (Band 1:L

Resizs (Mask (Mask (Band 21La
Resize (Mask (Mask (Band 312
Resize (Mask (Mask (Band 412
o Resize (Mask (Mask (Band 512
Resize (Mask (Mask (Band 6.1
i Map Info

- Memory1]

Resize (Mask (Mask (Band 1:La

-0 Resize (Mask (Mask (Band 2:La
°

-0 Resize (Mask (Mask (Band 4:La
O Resize (Mask (Mask (Band 5:La
O Resize (Mask (Mask (Band 6:La

lap Info

o

Dans le menu la fenétre ENVI de I’image choisissez Tools > Scatter plot
band choice

-> choisissez une bande pour chaque axe X : bande 4 et Y :

bande 3 > OK

Le scatter plot présente un histogramme bidimensionnel sur fond noir. Les
points blancs représentent les pixels en fonction de leurs comptes numériques sur
les deux bandes PIR et Rouge.

En déplagant le carré sur la fenétre affichant le scroll, I’histogramme va étre modifié sur le scatter plot.



3.2 Visualisation colorée de I'histogramme bidimensionnel

Driroere DU e

File Class Help Menu o
0 Change Bands... :
Density Slice Dans la fenétre scatter plot = option—> density slice.
Select Density Lookup...
Scatter: Dance Sur la fenétre « Scatter plot », en choisissant le menu « Option » et
Scatter: Zoom
Image: Dence « Density slice ».

Image: ROI

Image: Off

Clear Class
Export Class

Mean Class

Clear Al
Export All
Mean All

7 Profile...
Set Patch Size..
Set X/Y Axis Ranges..
Reset Range

Reset Size

£] #1 Scatter Plot (== = ]

File S ————

On peut avoir une meilleure visualisation avec des nuances de couleurs
distinguant les zones d’eau de celles de la végétation ou de celles
correspondant aux sols nus, par exemple.

Sur le Scatter plot on peut délimiter des polygones qui correspondent a
des zones bien déterminées (la zone d’eau, celle de la végétation par ex).

- Identification d’un paysage par dessin de polygones : Menu :

En appuyant sur la souris (le bouton gauche) on peut tracer des polygones sur cet histogramme du «
scatter plot ».

Lorsque le polygone est fermé, un clic droit sur la souris permet de coloriser le sous-ensemble de pixels.
11 est alors possible d’identifier la nature du paysage en se basant sur I’image qui apparait sur la fenétre ENVI
et aussi sur la position relative des pixels dans 1’histogramme.

] #1 (RResize (Mask (Mas Tandeat boureareq 2006, . =8l
#1 (R:Resize (Mask (Mask (Band 4:Landsat_bouregreg_2006_... (==sli=hi

File Overlay Enhance Tools Window

] #1 Scatter Plot =olE] R ]

Zone d’eau représentant des valeurs faible en PIR (bande 4) et Rouge (bande 3).



4. Calcul des indices

Les indices s’obtiennent par une combinaison mathématique des bandes spectrales de ’image. Ils sont utiles pour
mettre en évidence ou rehausser certains types de paysage. Il existe plusieurs type d’indice. L’un des plus connu est
I’indice de végétation normalisé, le NDVI.

4.1 NDVI : ( Normalised Difference Vegetation Index)

4.1.1 Calcul manuel de I'indice NDVI
(PIR-R

—) NDVI
(PIR+R)

@[BES\CTODB] Classification  Transform  Filter Spectral Map Vector Topographic Radar Window Help
Resize Data (Spatial/Spectral)
Subset Data via ROIs
Rotate/Flip Data

NDVI =

Menu :
Basic tools 2Band Math

Layer Stacking

Convert Data (BSQ, BIL, BIP)
Stretch Data

Statistics 3
Change Detection 3

Measurement Tool

Band Math
Spectral Math

Segmentation Image

Region Of Interest 3
Mosaicking 3
Masking 3
Preprocessing 3

Previous Band Math Expressions:

Entrez cette équation dans la fenétre " enter an expression"
:NDVI = (float(b1)-float(b2))/(float(b1)+float(b2))

Le choix de I’expression float ou bit dépend du résultat attendu.

Save | Restore | Clear | Delete . . .
| | | | Pour les chiffres entiers mettez bit

Enter an expression:

|floatib 1Hloatb 2} float b1)floatib2)} Pour les chiffres relatifs mettez float
Add to List

Apres avoir écrire 1’équation, cliquer sur OK

QK Cancel | Help

La fenétre variables to bands pairings apparait

@ Variables to Bands Pairings - g

Exp:[floatib 1} foatb2)/ float b 11-ioatb2)
—> 1l faut donc choisir les bandes b1 et b2 indiquées sur 1’équation selon ce qu’elles
représentent..Pour de LANDSAT la bande 4 représente le PIR et la bande 3
O — représente Rouge c’est-a-dire le B1 : Bande 4 et B2 :B3

E\--ﬁ] [Memony1]
i+ 0 Resize (Mask (Mask (Band 1:Lanc
-0 Resize (Mask (Mask (Band 2:Lang

e Choisissez « memory » pour une sauvegarde temporaire, le temps de la session de

0 Resize (Maskc (Mask (Band 51and travail ou « file » pour sauvegarder définitivement les résultats > Ok.

-0 Resize (Mask (Mask (Band &:Lanc il
w1 ER Mar Imfn

q | T | 2

»

Map Variable to Input File ‘

‘ QK | Queue | Cancel| Help ‘” Clear




31| Awailable Bands List
File Options

=l M 3 N . . A .
= [E.E] T T———Ty— Sur la fenétre « available Bands list » vous verrez aparaitre 1’image
& [ME::;1']F"° correspondante a NDVI ( Band Math dans Memory 3 : le cas pour cet
-0 Resize (Mask (Mask (Band 1:L| exemple)
Resize (Mask (Mask (Band 2:L

Resize (Mask (Mask (Band 3:L-— . A, A, . .
Frosive (Moo (Mo (B 2.1 Le nouveau fichier apparait dans la boite « available Bands list » ( Band

Resize {Mask (Mask (Band 5:L Math dans Memory 3, pour cet exemple).
Resize (Mask (Mask (Band &:L

Map Info

Cliquez sur le nom du fichier dans « available band list » pour ouvrir
I’image de NDVI qui vient d’étre calculé

band math (float(b1)-float(b2))/(float(b1l)+float(b2))-> load band.

i* Gray Scale  RGB Color

Selected Band
Band Math {floatb 1}{loat bZ)) floati 1)+float

| Dims |25’5?x 1625 (Floating Point) [BSQ]

| Load Band |mmv||

4.1.2 Lier deux ou plusieurs images d’'un méme territoire

Menu

Bouton droit de la souris sur la vue de I'une des deux fenétres -> link display - OK

[amwn Bl - T |,‘3JE7E‘]

Fle BancTools Clasefication Transform _Filter Topographic Radar_Window Help ]

] Avaitable Bands List =@ 5 |

FileOptien

] #1 (RResize (Mask (Mask (Band 4Landsat bouregre.. =
veday Enhy i

THemen3] -
G Band Math (foxb)oa b2},
5 @ Moo rfo
= tHemony1] r
G Resize (Mask (Mask (Band 11
& Resie (Mask (Mask (Band 21
& Fesie (Mosk (Mask (Ban 3L
© Resiae (Mask (Mask (Ban 4L
© Resize (Mask (Mask (Band 5L
i  Fesie (Mesk (Mask Band 6L

Link Displays..

@ ep rfo
= @ Landeat Bourecrea 2006 = Geographic Link..
" Z Profile (Spectrum)...
 Gray Scale " RGB Color & \; ROI Tool.
I Selected Band | i Interactive Stretching..
| |Band Math (flostie 1 Hflost2)) float £1)-foat ) ¥ y e s
Save Zoom As...
e Cursor Location/Value.
¥ 3 Paeloa
e 2567 1625 (ostng Pord) 53] = ==

Display Window Styte

Load Band

- Scroll/Zoom Position

<Find Display>

] LinkDisply= I lmesl)  La fenétre link display apparait. Activer les vues a lier
Dispiay #1[Yes 4] Lo [T yoi i Display 1 : Yes
usp\aynz]@m Link xoff [1 yof [1

Dispaly 2 : Yes

Link Size / Postion  Display #2

Dynamic Oveday’ﬁ ﬂTmnsparenw(D—WD‘?.} 0 = Dinamic overlay . On

OK | Cancel

Cliquer sur OK

Tewar =5 b A EEr=]

e e e e ——— ]

] #1 (RResize (Mask (Mask (Band 4Landsat bouregre.. = =1 | 28 |

4] #2 Band Msth J+foatt.. (= EI] 58

File Overlay Enhance Tools Window File Overlay Enhance Tools Window




4.1.3 Ajout d’'une nouvelle bande (néocanal) dans une image multispectrale

Objectif : rajouter d’une ou plusieurs bandes supplémentaires pour augmenter la sensibilité a I’identification des
types de paysages

Menu :

Sur la fenétre ENVI cliquer sur « File » > Save as > ENVI Standard.

Open Image File
Open Vector File

Open External File >
Open Previous File »
Edit ENVI Header

Generate Test Data

Data Viewer

Save File As > ENVI Standard

Import from IDL Variable ErAnEe

Export to IDL Variable ascn

Compile IDL Module Arcliew Raster (bil)

IDL CPU Parameters ER Mapper File

T . ERDAS (Jan) File
IPEG2000

Scan Directory List .

Change Output Directory .

Save Session to Script TIFF/GeoTIFF

Execute Startup Script ESRI GRID

Restore Display Graup

ENVI Queue Manager
ENVI Log Manager

Close All Files
Preferences

Exit

51 | New File Builder

Selected ENVI Files for New File:

La fenétre New File builder apparait ;

Cliquer sur « Import File » pour choisir I'image.

Import File... | Reorder Files... I Delete I

Remove Superfluous Files ?INO I_TI

Output Resultto ™ Fle ¢ Memory

Enter Output Filename Choose | [~ Compress

[ Select Input File: File Information
EET/? bande File: C:\Users\lIham\Desktop'\répétition rap\décour . A A .
e e oy 30147 150 o Une deuxieéme fenétre apparait « Create New File Input
Landsat_Bouregreg_2006 ?\eTyp_er ENUV\kitsndsrd
SR
P, T Eoe 0t File »> choisissez I’image brute

Datum - WGS-84
Wavelength : None

Ui (4 Comer 120025 OK -> enregistrer votre fichier et puis mettez OK pour

Description: File Resize Resu, x
resize factor: 1.000000, y resize
focior: 1.000000. [Thu Jui 28

23337200 terminer 1’application..
[ patal Subset [Pl Scene Hsam affe u

[ spectral Subeet [[F78 Benes |

oK | cancat Open~|

£ New File Builder

Selected ENVI Files for New File:

L’image choisie va apparaitre sur la fenétre New File Builder Dans la fenétre « available Bands list
— = [ » apparait alors une nouvelle image comprenant 7 bandes (6 bandes de LANDSAT + NDVI considéré
comme une 7éme bande)..

Remove Superfluous Fies 7[No 1_‘['

Output Resuttto ¢ File M y

OK | Cancel




Create New File Input File

File: Information:

|Size: [Floating Point] 20,034,100 bytes
File Type : ENVI Standard
|Sensor Type: Unknowr

one
Upper Left Comer: 1204261
Description: Band Math Result

File: C:\Users\llham\Desktop \répétition rap\NDVI
Dims: 2665 1885 1 [B5Q]

‘ Spatial Subset [[Full Scene Hs.alen By]ﬁm|

T | |

Vous allez avoir sur la fenétre New File Builder les deux images
importées = mémoriser le fichier et mettez OK pour continuer

Sur la fenétre « available Bands list » vous allez voir apparaitre une nouvelle image comprenant 7 bandes (6bandes de
LANDSAT + NDVI considéré comme une 7™ bande).

4.1.4 Calcul automatique de NDVI

11 est possible de calculer et d’obtenir une image NDVI automatiquement. La démarche est la suivante :

Image Sharpening ¥

Band Ratios

Principal Components 3
MNF Rotation 13
Color Transforms 13
Decorrelation Stretch
Photographic Stretch

Saturation Stretch

Synthetic Color Image

NDVI (Vegetation Index)

Tasseled Cap

4.2 Autres combinaisons

Aprés avoir ouvert I'image qui servira au calcul de NDVI,
utilisez le module « Transform » et choisissez « NDVI
(vegetation index) », puis le type d’image (Landsat TM pour
cet exercice). Sauvegarder I’image. On obtient par la suite une
image de NDVI. Le fichier correspondant apparait dans
fenétre available Bands list..

Parmi les autres indices existants citons I’indice de clarté [ IC = (R -V) /(R + V) ou V représente la bande verte],

I’indice de brillance etc.

4.2.1 Indice de Brillance (IB)

Pour calculer I'IB, la formule est la suivante:

(IB =+/PIR* + R’ )

1B=~/PIR* + R* = (float(BV)Y +(float(B2))

4.2.2 Indice de Clarté (IC)

Pour calculer I'IC, la formule est la suivante :

1c - float(b1)—(floar(b2))
(float(b1))+(float(b2))

4.2.3 Indice d’humidité (INH)

(MIR-V)
(MIR+V)
Sachant que le MIR est le Moyen Infra-Rouge et le V, la bande Verte

INH =



5. Seuillage
Objectif :

Le seuillage permet de masquer ou de ne faire apparaitre qu’une partie d’une image en se basant sur les valeurs
radiométriques des pixels

File ools _Classification _Transform _Filter Spectral _Map _Vector Topographic Radar_Window _Help ]
] #1 Resize (Mask (Mask (Ba: ,

File Overlay Enhance

Pour visualiser les valeurs des pixels, faire un clic
droit, Choisissez « cursor location/value ».
Déplacer ensuite le curseur de la souris sur la bande
de I’'image choisie

Link Displays..
Geographic Link...

Z Profile (Spectrum)..
ROI Tool...

Interactive Stretching...
Save Image As...

Save Zoom As..

Cursor Location/Value..

Pixel Locator...
Toggle

Display Window Style

Scroll/Zoom Pesition

<Find Display>

] #1 Resize (Mask (Mask (Band

v File Overlay Enhance Tool
= 1Y

.
£ Cursor Location / Value = |8 %

File Options

Disp #1(1771,703) Scm: R:0G:0 B:0
Projection: UTM, Zone 30 North

Map: 158085.00E,3764355.00N Meters
LL : 33°5750.98"N, 6°41'59.79"W
Data: 26

Valeur de I’eau dans la bande 4

Cette figure montre les valeurs de 1’eau dans la bande 4 de LANDSAT (ne dépassant pas les 35, la valeur affichée sur
la figure ci-dessus est de data : 26).

En appliquant le mask vous pouvez filtrer et €labores les valeurs radiométrique de 1’objet étudié.

Bl enviaL) [=iEE=) Menu:

Basic Tools | Classification _ Transform _Filter Spectral Map Vector Topographic Radar Window Help |

Resize Data (Spatial/Spectral)
Subset Data via ROIs
Rotate/Flip Data

Layer Stacking

Convert Data (350, BIL BI) Basic tool, puis choisissez masking ->build

Stretch Data
e mask

Statistics »
Change Detection ,

Measurement Tool

Band Math
Spectral Math

Segmentation Image

Region Of Interest v

Mosaicking >

Masking £ Build Mask
Preproceszing ) Apply Mask .




Select Input Display:

\

No Display Choisissez la fenétre dans laquelle s’affiche I’image a traiter (le display 1 dans cet
exercice) 2 OK

£7] #1 Mask Definition [ licnli=h |
File (Options |

Import Data Range...

I rt Annotation... A oge A
S Ponmnnosen La fenétre Mask Definition apparait
Import ROIs...
Import ROl Intersection... Importer votre image en cliquant sur Option = Import data range
Import EVFs..

Import Displayed Annotation

Mask Finite Values
Mask NaM Values

Selected Areas "Off"
Qutp . . , e,
Selected Areas "0n" 4——— L Pour afficher les valeurs correspondantes au seuillage de 1’objet étudié, il

T faut cocher le select Areas « ON »

Selected Attributes [Logical AND]

Apply | Cancel |

1 g

Normalement ¢a s’active automatiquement

La zone a mettre en évidence sera codée sur 1 et la zone masquée sera codée sur 0.

] Select npot for Mok D foras ‘ == La fenétre correspondant aux différentes
NDVI automat seec A File: C'\Users\Ilha:lf[ll::dnz:t\ir.gémion rap‘découp images utiliSées en cours d’utﬂisation S,OuVre
Teme bands gﬂf:[ﬁgﬂ%ﬁ% gﬂ[ﬁg! . Sﬁle'c't Inpllg For ‘Maskll Datfa) ] Range).
Fie Iﬁﬂ ENVI S oisissez 1’131age a seuiller (Découpage

Byte Orci - Host (el pour ce cas d’étude)
PE%?:E“S{;L%EHEMM | Sur « Spectral subset » vous devez choisir

VWavelengih : None une seule bande (avoir 1/6 Bands au lieu de
Upper Left Comer: 1204,261

Description: File Resize Result, x 6/6 Bands).

resize factor: 1.000000, v r=size
Factor: 1.000000. [Tnu Jul 28

23223 2011) Cliquer sur cette icone et choisissez une
seule bande spectrale (Bande 4 pour cet
st fe 3] exercice)

‘ Spectral Subset "&"6 Bands ‘

‘ QK | Cancel |H Previous | ‘ ('.hmVH

31| File Spectral Subset

Select Bands to Subset

Cliquez sur Bande 4 -> Ok sur les deux derniéres fenétres
ouvertes.

4 1

Number of items sslected: |1
[ [ AddRange | Select Al | Glear | import ASCIL.

oK | Cance%l F'reviousl

La fenétre Input For Data Range Mask apparait

Dans les deux cases Data Min Value et Data Max Value, il faut mettre les valeurs numérique correspondantes au
Valeurs affichées sur le cursor localion value du paysage choisi et sur lequel vous voulez appliquer le mask



@ Input for Data Range Mask LéJ

Selected Input:
|Band' Resize (Mask (Mask (Band 4:Landsat_|

Select New Input... |

Data Min Value (10
Data Max Value |35

OK | Cancel

4] #1 Mask Definition
File Options
Samples [2665 Lines | 1825

Selected Attrbutes for Mask:
10 - 35: Resize (Mas!

o | e S

Delete tem | Delete All kems

Output Resultto @ Fle Memory

Erter Output Filename Choose | [ Compress

Apply | Cancel

] Available Bands Listﬂ-ﬂ—

File

Options

seuillage Mask

Band 1
Band 2
Band 3
Band 4
Band 5
Band &

* Gray Scale " RGE Color

Selected Band

Mask Band:seuillage Mask

| Dims |2555x 1885 (Byte) [BSQ]

Load Band | Display 81~

Par exemple les surfaces d’eau dans ce cas de figure, les valeurs

numériques ne dépassent pas les 35. On peut mettre donc comme
valeurs :

Data Min Value: 10 et Data Max Value :35
- 0OK

Les valeurs choisies s’affichent sur la fenétre « Mask definition » 2>

enregistrez votre fichier et cliquez sur Apply

L’image correspondant au Mask sera automatiquement affichée sur la fenétre
Available Bands list

ask Band:seuillage Mas}
#1 Mask Band: llage Mask

|= = ]

File Overla

Enhance Tools Windo

%] #1 Scroll (0.09606) -I (o s e | #1 Zoox

m [4x]
|

La zone de I’image visible (en blanc et codé sur 1)
correspondant aux zones humides ayant des valeurs de compte

numériques comprises entre 10 et 35, comme précédemment
indiqué.




6. Application d’'un Mask radiométrique a I'image brute

gl

File | Basic Tools | Classification Transform  Filter Spectral Map Vector Topographic

Resize Data (Spatial/Spectral)
Subset Data via ROIs
Rotate/Flip Data

Layer Stacking

Convert Data (BSQ, BIL, BIP)
Stretch Data

Statistics 3
Change Detection 3
Measurement Tool

Band Math

Spectral Math

Segmentation Image

Region Of Interest 3

Mosaicking 3

Masking 3 Build Mask
Preprocessing 2 o

Radar Window Help

Menu :

Sur la fenétre correspondante & ENVI, appuyez
sur Basic Tools et choisissez masking - apply
mask

La fenétre Apply Mask input File s’affiche, choisissez I’image brute se laquelle sera appliquer le MASK‘

4] Apply Mask Input File

Select Input File

File Information:

seuilage Mask
NDVI automat
fieme bande

LandsatEauregreg_ZDDE

Dims: 2665 1885x 6 [BSQ]
Size: [Byte] 30,141,150 bytes
File Type : ENVI Standard
Sensor Type: Unknown

Byte Order : Host {Intel)

File: C:\Users\llham'Desktop'répétition rap‘décour

Sur I’icdne Select Mask Band, il faut choisir le Mask que vous
venez de créer (seuillage| Mask pour ce cas d’étude).> OK

Projection : UTM, Zane 30 Noth
Fixel : 30 Meters
Datum - WGS-84
Wavelength - None
Upper Left Comer: 1204 261
Description: File Resize Result, x
resize factor: 1.000000, y resize
factor: 1.000000. [Thu Jul 28
22:33:37 2011]

‘ Spatil Subset [[Ful Soene ” Select wIFFTj‘
‘ Spectral Subset W——‘

‘ Select Mask Band ]WH Mask Opliores
‘ﬂw| Previous ‘M

Enregistrer le fichier et continuer

(sur les deux dermicre fenétres).

%] Select Mask Input Band‘ ﬁ

Seledt Mask Input Band
[=]- %% seuillage Mask -

NDVI (découpage)
Map Info

Band 1
Band 2
Band 3
Band 4
Band 5
Band &
Band 7
Map Info

o Band Math {floatb1Hloatb2)l/fle
It b

0K | Cancel

File Qverlay Enhance Tools

File Options

] ENVIAL [SlEE=
[ File Basic Tools Classification Transform _Filter Spectral Map Vector Topographic Radar Window Help ]
] *#1 Mask (Resize (Mask (Mask (Band 3:Landsat_bour... =S 1% Available Bands List S=RUCT

5 Le nom de I’image finale apparait dans la fenétre.

- =pply Mask

o

o
o
o
o

B9 seuilage Mask

o

NDVI automat

Mask (Resize (Mask (Mask (Band 1.1
Mask (Resize (Mask (Mask (Band 2.5
Mask (Resize (Mask (Mask (Band 3. =
Mask (Resize (Mask (Mask (Band 4:L3
Mask (Resize (Mask (Mask (Band 5:L5
Mask (Resize (Mask (Mask (Band 6:L;
Map Info

Mask Band
Map Info

NDVI (découpage)

Available Bands List

¥ Gray Scale ¢~ RGB Color

Selected Band

[Mask (Resize: (Mask (Mask (Band 3:Landsat_boureg

#1 Zoom [4x]

‘ Dims [2665 1885 (Byte) [BSG] |

Load Band | Desphay 1|




7. Masque géographique : création d'un ROI
Objectif :

La création d’un masque géographique permet découper une partie de ’image a partir a partir d’un polygone. Cette
procédure aide a délimiter la zone d’étude sur une image brute.

La création d’un masque géographique peut se faire a partir de : - de régions d'intérét (ROI) ou de fichier vectoriel (.
evf, .shp, .mif)

F=E =)

Resize Data (Spatial/Spectral)
Subset Data via ROIs
Rotate/Flip Data

Layer Stacking

Convert Data (BSQ, BIL, EIP) .
Stretch Data Menu .

Statistics » o .

Change Deection . Basic tools = Region Of Interest =
Measurement Tool

Band Math ROI tool

Spectral Math

Segmentation Image

Region Of Interest y ROITool
D= ' Restore Saved ROI File
Masking ' Save ROIsto File
Preprocessing , Delete ROIs
Export ROl to EVF
Export ROIs to n-D Visualizer
Output ROTs to ASCT

Reconcile ROz

Reconcile ROIs via Map

Band Threshold to ROI
Create Class Image from ROIs
Create Buffer Zone from ROIs

Compute RO Separability

EET [=rE=w)

File ROLType Options Help

Window:  Image  Scroll ¢ Zoom ( OFf

: La fenétre ROI Tool s’affiche. Choisissez la fenétre sur laquelle vous
| ROI Name | Color | Pixels |Fcl)'gons‘ L, . .
Fogon#1 Fied 7 ) n désirez dessiner les polygones (Image, scroll, Zoom).
[

Délimitez votre zone d’étude a ’aide la souris en faisant des clics gauche
et 2 clics droit pour fermer le polygone et terminer

| +
‘ New Region | | Goto | Stats | Grow | Fixel | Delete |

‘ Select Al ||| Hide ROIs | Zhow s |

Cet exemple montre la délimitation d’un ilot de
forét sur I’Image..

File ROLType Options Help

Window: © Image " Seroll " Zoom " OF

Pour effacer un polygone, sélectionner la ROI
dessinée et cliquer sur Delete

Ch | v -
New Region ||| Goto | Stats | Grow M Delete

Select All Hide ROJs | Show Rils




Pour enregistrer une ROI, utilisez le Menu File

A partir de ce menu on peut exporter des ROIs (Export ROIs to ...) sous forme de fichier vectoriel ENVI (EVF...)
qui peuvent exporter par la suite en fichier .shp, utilisable sur ARCGIS et ArcView.

ROLType Options Help
Save ROE...
Restore ROE...

Subset Data via ROls Dans cet exemple, le ROI sera enregistré au format .evf

Export ROIs to EVF...

Export ROIs to Shapefile...

Export ROIs te n-D Visualizer...

Output ROIs to ASCIL..

Cancel

[ setectu ||| e Fois | 5o rioe |

7] Export RO to EVF

Select ROls to Export

Forét [Red] 31259 poirts

e La fenétre Export ROIs to EVF apparait ;
Scket tens | e At | Il faut enregistrer le fichier en lui attribuant un Nom (Forét pour cet exemple) > OK

Treat Individual ROI Paints:
(¥ Each point as a separate record

" Mlpoints as one record

Output
Forét

Output Resuttto & File " Memory

Enter Output Filename [vf] Choose

[C:Users\lham Desktopvépatiion rap EVF vt

OK | Cancel

] Available Vectors List (o EH eS|
File Options Pour ouvrir I'image correspondant au ROl faut sélectionner le fichier sur
Available Vector Layers: la fenétre qui apparait (Available Vectors List) et

cliquer sur Load Selected.

Name: Forét

File: C:\Users\llham"“Desktop"répétition rap \EVF evf
Size: 5,112 bytes

Records: 1 [265 nodes]

Proj : UTM, Zone 30 North [Meters]

Datum: WGS-84

Aitributes: No

Selsct Al Layers | Desslsct Al Layers |

Load Selected | Remove Selected ||

Une petite fenétre s’ouvre permettant le choix de la fenétre d’ouverture du fichier.

Select Vector Window Choisissez une fenétre et puis cliquez sur OK pour continuer.

Mew Vector Window




] #1 Vector Parameters : Cursor .. = ]
File Mode Edit Options Help

Window: |  Seroll  Zo o Off A : A : .
e mege T Sem o Sur la fenétre qui apparait, par la suite, choisissez une couleur d’affichage en

Available Vector Layers . I3
il cliquant sur les carreaux colorés

= Apply. Vous remarquez les changements de couleurs du ROI au
moment de I’affichage.

Current Layerl:‘ Cument Highlight D

Location
Export |

‘ Apply |H‘Mndow W Image W Scroll W Zoom ‘

Enregistrement du ROI

£7] #1 ROI Tool
[File] ROLType Options Help
Save ROIs...

Restore RCEs. Pour I’enregistrement il suffit de cliquer sur Save ROI dans le Menu File de la
Subset Data via ROIs fenétre ROI Tool.
o

Export ROLs to EVF..
Export ROIs to Shapefile...
Export ROIs to n-D Visualizer...

Output ROIs to ASCIL.

Cancel

‘ setect A || Hide RO | 5o s |

8. Création d’'un Mask a partir d’'un ROI

=)

Basic Tools | Classification _Transform _Filter _Spectral Map Vector Topographic Radar Window Help |
Resize Data (Spatial/Spectral) F

Subset Datavia ROl Menu: Basic Tools > Masking 2 Build Mask

Rotate/Flip Data
Layer Stacking

Convert Data (BSQ, EIL, EIP)
Stretch Data

Statistics »
Change Detection »

Measurement Tool

Band Math
Spectral Math

Segmentation Image

Region Of Interest »

Mosaicking »

Masking v Build Mask
Preprocessing - Apply Mask ‘

File I Opticns

Import Data Range...

Impert Annotation...

mpod RO La fenétre du Mask definition apparait, importer I'image en cliquant sur « options » et
Import ROl Intersection... ..

choisissant Import ROIs
Import EVFs...

Import Displayed Annotation

Mask Finite Values
Mask NaM Values

Outp Selected Areas "Off"
Selected Areas "On”

Selected Attributes [Logical OR]
Selected Attributes [Legical AND]

Apply | Cancel |




=
Available Bands List

Enter ROI Filenames ===

File Options

masic ROl forét
o
Mep Ifo
= découpage

o Resze (Mask (ask (Band 1:Land
Resize (Mask (Mask (Band 2Land
Resize (Mask (Mask (Band 3Land
Resize (Mask (Mask (Band 41.and

EE

Nom Date de modification  Type Taille
|_IROI Forét.roi

-

Bureau Taille: 2,27

o
o
o
o
o

- Date de modification : 30 Resize (Mask (ask (Band 5:Land
9 Orchnateo Resize (Mask (Vask (Band 6:Land
B Images Map Info
e <o v
5 Modifié récemment & GroyScdle € RGBColor
B Recherches

Public Selected Band

Mask Bandmask ROIforét

Dossiers ~

Nom du fichier - RO Forét.roi v |Rol v
— Dims 2665 x 1885 (Byte) [BSQ]
Ourr | [ Aonuer |
Load Band | Disphay #1|

(=[=] =

Available Bands List = | S| 2 ]

o0 mask RO forét
Mask Band

& ap Irfo
=l découpage 3
Resize (Mask (Mask (Band 1:L|=
Resize: (Mask (Mask (Band 2L
Resize (Mask (Mask (Band 3L,
Resize: (Mask (Mask (Band 4:L
Resize: (Mask (Mask (Band 5:L
Biccize Mbmske Mmcke (Rt £:1

o

ZShoooo

@ Gray Scdle  ( RGE Color

Selected Band

Mask Band mask ROI forét

Dims [2665 1885 (Byte) (B5Q]
Load Band | Despliay #1 ]

L’application d’un masque exige le choix de I’image d’entrée et du Masque dans Select Mask Band.

Le Masque doit avoir été créé a partir de I’image sur laquelle il va s’appliquer.

4] Apply Mask Input File =]

%] Select Mask Input Band ==
Fle Information T
Fie: C:\Users\lham\Deskiop vépéiiion rap'd2coup

[ Select Input File:
apply Mask

Select Mask Input Band

S sooly ok Bz

: Mask (Resize: (Mask (Mask (Band|
Mask (Resize (Mask (Mask (Band|
Mask (Resize (Mask {Mask (Band|
Mask (Resize: (Mask (Mask (Band|
Masc (Resize (Mask {Mask (Band|
Mask (Resize (Mask {Mask (Band|

o

Frojection : UTW. Zone 30 North
Pocel - 30 Meters
Datum - WGS-84
Wavelength : None

ooooao

Upper Left Comer: 1204261 Map Info L
[Descipton: Fie Resize Resut 9% mask ROl forét
ol Vask Band
Map Info

=
i
2l
Bk
g
g

= découpage
5 Resize (Mask (Mask (Band T-Lang

O Resize (Mask {Mask {Band 2:Land
‘ Spatial Subset \ Full Scene ‘ Select By [File ﬂ| O Resize (Mask {Mask (Band 3:Lanc
o Resize (Mask (Mask (Band &Lane
‘ SpscirlSubse [[E76 Bands ‘ O Resize (Mask (Mask (Band 5:Lzne _
m D

[ etect Mask Band |[ene Selected> [ e cpsmes ]

Apply Mask Parameters ==

Mask Value |0

Output Resultto © File ¢ Memory

Erter Output Filename Choose | [~ Compress

‘C “Userstllham"\Desktop'wépétition rap*apply mask

OK | Queue | Cancel

*1 Mask (Resize (Mask (Mask (Band S:iLandsat bour.. | [ =1 | 58 |




9, Classifications d’

La classification d’image permet

images

de regrouper les pixels dont les signatures spectrales sont proches. Le but final

d’une classification d’image est de réaliser des cartes thématiques comme par exemple des cartes d’occupation des

sols.

11 existe 2 types de classification :

La classification non supervisée ou automatique et la classification supervisée

9.1 C(Classification Non supervisé ou automatique

La classification non supervisée correspond a une segmentation de 1’image en n classes. ENVI propose 2 méthodes

9.1.1 Méthode Isodata

Menu : Classification > Unsupervised > Isodata

ENVI propose de choisir une

image de travail. Vous choisissez I’image, la boite de dialogue « Isodata

Parameters » s’affiche Elle permet de fixer les paramétres de calcul :

- Le nombre des classes

- Le nombre des itérations

Menu : sur le menu classification choisissez le module Unsupervised

File Basic Tools | Classification | Transform  Filter Spectral

Supervised 3

Unsupervised 3

Decision Tree

=T
Map Vector Topographic Radar Window Help H

IsoData
K-Means

Endmember Collection

Create Class Image frem ROIs

Post Classification »

La fenétre « Classification Input File »
s’ouvre :

7] Classification Input File

Select Input File:

Fie fomaton Choisissez I’image brute sur laquelle vous souhaitez réaliser la

msk découpage File: C:\Users\lIhar

Wavelength - Non
Upper Lef: Comer

Datum - WGS-84

Description: File Resize Result

m\Deskiop\répétfion ap\décour

Dims: 2665x 1885 6 [BSQ] classification.
Size: [Byte] 30,141,150 bytes
File Type : ENVI Standand . A L.
o e Cliquez sur I’icone « Select Mask Band » pour choisir un

Projection : UTM, Zong 30 North
ers

masque, si nécessaire Le masque est utile si vous souhaitez
1204261 exclure certaines zones de la classification.

| Spatial Subset |[Full Scene |

| Spectal Subset [[676 Bands |

| Select Mask Band ||<Mone Selected> H Mak Opliawns ‘

[oc [ [ oo [ ]

Select Mask Input Band i g

Select Mask Input Band

mask découpage

=X

lap Info

= ﬁ] découpage

Resize (Mask (Mask (Band 1:Landsat
Resize (Mask (Mask (Band 2:Landsat
Resize (Mask (Mask (Band 3:Landsat
Resize (Mask (Mask (Band 4:Landsat
Resize (Mask (Mask (Band 5:Landsat
Resize (Mask (Mask (Band 6:Landsat
lap Info

Pour valider cliquer sur OK

ISODATA Parameters.

En cliquant sur I’icone « Select Mask Band », la fenétre select Mask Input Band
s’ouvre, choisissez 1’image correspondant au Masque : Mask découpage pour cet
exemple 2> OK

Number of Gasses: Mn[5 @M | [ (o sty FromMlean | Une nouvelle fenétre s’ouvre : « Isodata Parameters » et ou on
Vamm bemtons |1 2 Maxnum Dstance Erer | peut lire :

Change Threshold % (0-100) 5.00

Minimum # Pixelin Class |1 =
Maximum Class Stdv 1.000
Minimum Class Distance  |5.000

Output Resuftto

=

Number of Classes : Min / Max : nombre de classes,

- Maximum Iterations : nombre maximum d’itérations,

Maximum # Merge Pais 2 &

0K Queue | Cancel | Help

- Change Threshold % : taux de changement de pixels en %,

- Minimum # Pixel in Class : nombre minimum de pixels

_—————— nécessaires pour constituer une classe



Pour cet exemple nous avons Choisi un nombre de classe entre 5 et 10 et pour le nombre des itérations nous avons mis

5 pour diminuer les marges d’erreurs.

Apres avoir fixé les parametres, valider par OK pour lancer la classification.

&) envial

=[E] %

File Basic Tools Classification Transform Filter Spectral Map Vector T

opographic Redar Window Help

4] #1 ISODATA (découpage)«classification isodata EEI

File Overlay Enha T

= | =] 5%

9.1.2 Méthode K-Means

Supenvised »
IsoData
K-Means

Unsupervised 2

Decision Tree

£] #2 (RiResize (Mask (Mask (Band #:Landsat_bouregre... = | B T2

—
> RS !
] Available Bands List File Overlay Enhance Tool

File Options
- 9% mask découpage
Mask Band
Map Irfo
oupage
Resize (Mask (Mask (Band 1:L
Resize (Mask (Mask (Band 21| _
Resize (Mask (Mask (Band 3:L|
Resize (Mask (Mask (Band 4:L
Resize (Mask (Mask (Band 5:L
Resize (Mask (Mask (Band 6:L

oooooao

-8 Mao Irfo
<Lm v

" Gray Scale & RGB Color

= R [Resizs (Mask (Vask (Band &Lands
G [Resize (Mask (Mask (Band 3:Lands
B [Resize (Mask (Mask (Band ZLands

Dims [2665 x 1885 (Byte) [BSQ]
Losd RGB | Desplowy £2 ~|

File Basic Tools [Classification | Transform _Filter Spectral

Sur le Menu : choisissez le module
« classification » - unsupervised > K

Endmember Collection

Create Class Image from ROIs

Post Classification b

Means

Select Input File:
classfication isodata

Flle
File: C.\Users\lhamDesktop\répélition rap\découp
Dims: 2665 1885 6 [BSQ]
Size: [Byte] 30.141.150 bytes.
File Type - ENVI Standard
|Sensar Type: Unknown
Byte Order - Host (Intel)
Frojection : UTM. Zone 30 North
ers

mask découpage

Datum - WGS-84
Wavelength : None
Upper Left Comer: 1204,261
Description: File Resize Resul

| Spatial Subset [[Full Scene ‘
| Speciral Subset ||W|
| Select Mask Band |[<None Selected>

[_ox | caret [ i [ v

=

 —r—

21 | K-Means Parameters J
5 §
Change Threshold % (0-100) [5.00

I

Maxdmum Stdev From Mean I
I—

Output Resultto ¢ File %

MNumber of Classes

Maximum lterations

Maximum Distance Emor

| oK | Queus | Cancel | Help |

Choisissez 1’image brute sur laquelle vous souhaitez
réaliser la classification.

Cliquez sur I’icone « Select Mask Band » pour choisir
un masque, si nécessaire.

Une nouvelle fenétre apparait « K-Means parameters »
Choisissez les paramétres de classification

Pour cet exemple on a mis 5 classes et 5 itérations. Pour valider mettez
OK et lancez la classification



Les résultats de la classification s’affichent automatiquement dans la fenétre Available Bands list.

9.2 Classification supervisée

La classification supervisée est basée sur 1’utilisation d’un et éventuellement d’un masque, si des régions de ’image

sont a exclure.

9.2.1 Exemple de création d’'un ROI en vue d’une classification:

Resize Data (Spatial/Spectral)
Subset Data via ROIs
Rotate/Flip Data

Layer Stacking

Convert Data (BSQ, BIL, BIP)
Stretch Data

Basic tools
Tool.

Statistics »

Change Detection >

Measurement Tool

Band Math

Spectral Math

Segmentation Image

Region Of Interest » ROI Tool

Mosaicking v Restore Saved ROI File
Masking >

Save ROIs to File
Delete ROIs

Breprocessing >

Export ROIs to EVF
Export ROIS to n-D Visualizer
Output ROIs to ASCI
Reconcile ROIs

Recancile ROIs via Map

Band Threshold to ROI
Create Class Image from ROIs
Create Buffer Zone from ROIs

Compute ROI Separability

File ROIType Options Help

7] #1 ROI Tool ="

Window: ¢ Image * Scroll ¢ Zoom ( Off

<l

RCI Name | Color | Pixels |Pohrgons|
_ |Red 0 0/0

U

r

| New Region |

‘ Gotol Statsl Growl Pixell Delete |

| Select Al |H Hide ROIs | Show A0 |

%] #1 (RResize (Mask (Mask (Band #1andsat bouregre... .= | =] %% |

File Overlay Enhance

Tools  Window

] #1 R0l Tool

File ROLType Options Help

Window: ¢ Image  Scroll & Zoom ¢ Off

Pocels | Polygons

643 1/643

ROIName | Cobor |
eau 1 Red

4 [l r

‘ Hew Region ||| Goto | stes | Grow | Pl | Desese ||

select 1 || e rots | i

- Pour remplir le tableau il faut :

- Region Of Interest

5| La fenétre ROI Tool va apparaitre

Afin de dessiner les polygones il faut choisir

2>ROI

Dessiner les polygones sur le scroll, I’'image ou le zoom en
activant la case correspondante.

Dessiner des polygones sur I’image brute affichée. Avant de
dessiner le deuxieme polygone il faut donner un nom au premier
en modifiant la case « Region »

Pour garder le nom qui vient d’étre entré dans la case « Region »,
sélectionner la case « Region » suivante



Il suffit de cliquer sur new Region pour
ajouter d’autres polygones comme le montre
la figure ci dessous.

File ROLType Options Help

Window: € Image ¢ Scrol & Zoom < Off

| ROINeme | Color | Pels | Polygons |
forét2 Yelow 223 7243 .

50l nu Cyan 340 1/340
culture Magerta 1,001 2/1,001
forét 3 Maroon 580 1/580 ‘:‘ . . .
e Apres avoir terminé le dessin de tous les
| S S S | polygones, enregistrer votre ROI
Hide ROIs | Show ROIs

| Save ROIs to File

Select Regions to Save:

cau 1 (2665¢1885) [Red] 43 points Pour sauvegarder le ROI faire, file save ROIs —>sélectionnez toutes les
eau 2 (2669c1885) [Green] 159 points Aot tA :

o EE855) o] 254 o te régions souhaitées, puis appuyez sur choose
forét2 (2665:1885) [Yellow] 243 points

sol nu (266%:1885) [Cyan] 340 points
culture (266%¢1885) [Magerta] 1001 paints
forét 3 (2665¢1885) [Maroon] 580 points

Valider en cliguant sur OK

Number of items selected: IB

Select Al ltems | Clear Al tems |

Enter Output Filename [roi] Choose

oK | Cancell

Le fichier ROI peut étre exporté au format EVF puis au format SHP utilisable sous ARCGIS.

7] #1 R0 Tool e ] |

[File| ROLType Options Help
Save ROEs...
Restore ROE...

Subset Data via ROls

Export ROIs to EVF...
Export ROIs to Shapefile...
Export ROL: to n-D Visuslizer...

Output ROIs to ASCIL...

Cancel

‘ select Al [ Hide Rols [ show R ||

9.2.2 La Classification Supervisée

ENVI propose d’utiliser plusieurs méthodes de classification supervisée. Dans cet exemple, nous utiliserons la
méthode du maximum de vraisemblance ou Maximum Likhood

Sur le Menu principal, Choisissez le module classification > Supervised > Maximum Likelihood
=

Basic Tools [ Classification | Transform _Filter Spectral Map Vector Topographic Radar Window Help

Supervised v Parallelepiped

Unsupervised v Minimum Distance

Decision Tree Mzhalanobis Distance

Endmember Collection Maximum Likelihood

Create Class Image from ROIs Spectral Angle Mapper

Post Classification v ST EEsEl

Neural Net




@ Classification Input File

Select Ipt Fil: e Select Mask Input Band
mask décounege Fie: C:\Users\lham\D
découpage Dims: 2665 1885 6
Size: [Byte] 30,141,150
File Type: - ENVI Stand
Sensor Type: Unknown
Bite Order : Host (intel

La fenétre classification Input File apparait. Sur cette
fenétre il faut choisir I’image brute sur laquelle vous
voulez réaliser la classification supervisée.

mask découpage
:
‘ Map Info
Eﬁl découpage

-0 Resize (Mask (Mask (Band 1:Landsat
Resize (Mask (Mask (Band 2:Landsat
Resize (Mask (Mask (Band 3:Landsat
Resize (Mask (Mask (Band 4-Landsat
Resize (Mask Mask (Band 5:Landsat
Resize (Mask (Mask (Band 6:Lzndsat
Wap Info

Cliquez sur I’icone Spatial Subset, puis sur Open >
ROI File. Choisissez alors le ROI comprenant les
différents classes thématiques..

Datm : WGS34
Wavelength : Nane
Upper Left Comer: 120

i
i

o

b
Descrption: Fle Resizeff E

File: découpage
Dims: 2665 x 1885 (Byte)

‘ Spatial Subset ||Full Scene “
‘ Spectrel Subset {|6/6 Bands ‘
‘ Select Mask Band ||cNone Selected H Mk Ol

o] oo

Samples I To |2665 NS |2665

Lines |1 To|1885 NL|1885

Full Size : 5,023,525 bytes
Subset Size: 5,023 525 bytes

Subset Using

image | Map | Fie | ROVEVF | Serol |

Subset by Image Input Band|1 g

. - A , . . , . Reset | Previ Open ~
Cliquez sur I'icone select Mask band pour sélectionner, si nécessaire le \M“ |

Masque correspondant a la zone de I’'image a exclure de la classification. | | ROIFile..
q p & oE || e EVF File...

5] Maximum Likelihood Parameters

Select Classes from Regions
eau 1 [Red] 643 paints
eau 2 [Green] 159 poirts

forét [Blue] 254 points Enter Output Class Filename Choose | ™ Compress
w] 243 poinits

Output Resultto & Fle ¢ Memary

La fenétre Maximum Likelihood s’affiche ensuite,
Choisissez les classes thématiques du ROI qui serviront
Output Fie Images 2[Yes 41| dans la classification. Donnez un nom a votre
R (8 e classification, puis valider pour lancer la classification

C:\Userslham'\Desktop'wépétition rap*class SUP

poirts
Suitire [Magentz] 1007 poirts Enter Output Ruls Flename Chooss |
Number of items selected:[9 C:\Users'lIham\Desktop'répéition rap\class SUP

Select All liems | Clear Al ftems

Set Probability Threshold

£ Mome {* Single Value ¢ Multiple Values

Frobability Threshold
Data Scale Factor [255.00

‘ 0K | Queve | Cancel ﬂl” Pre\new‘

File Options

E-H;. class SUP

Map Info

lass SUP

Rule feau 1 [Red] 643 poirts)

Ruls {sau 2 [Green] 159 poirts

Rule forét [Blue] 254 paints)

Ruls Forét2 [Yellow] 243 points

Rule fsol nu [Cyan] 340 paints)

Rule {cutture [Magenta] 1001 ¢

Rule forét 3 [Maroon] 580 poir ~
L3

| »

i

¢ Gray Scale  * RGB Color
co [EEGmT
g [ ooy SO

‘nms|2essx1sss(ayte) 5] |

Load RGE | Disphay #1+




a. Changement des couleurs sur I’'image de la classification Supervisée.

Objectif : Modifier les couleurs de I’'image pour améliorer et faciliter la lecture de la carte tout en se basant sur la
connaissance du Terrain.

Menu : sur la fenétre de I’image correspondant a la classification supervisée,

Link

Profiles

Polarization Signatures

Region Of Interest

Color Mapping ENVI Color Tables.

Do Cliquez sur le menu Tools > Color Mapping -
Control RGB‘I‘;’nagEP\ane;.‘. Class Color Mapplng

Class Color Mapping...

Cursor Location/Value...
Pixel Locator...
Point Collection...
Build Mask...

Measurement Tool...

Line of Sight Calculator...

Spatial Pixel Editor...

Spectral Pixel Editor...
Animation...

2D Scatter Plots...

3D SurfaceView...

File Options

Selected Classes:
Unclassified

eau 1[Red] 643 poirts

au 2 [Green] 159 poirts
o3t [Elue] 254 painits

forét2 [Yellow] 243 points

sol nu [Cyan] 340 points
cuture [Magenta] 1001 poirts
for2t 3 [Maroor] 580 poiris
cuture 1 [Sea Green] 629 points
<ol nu 1 [Puple] 614 poirts

Class Name

[rclassfeds
oo | N |
4 I FE
il 2FE
Al FE

Pour enregistrer les changements des couleurs il suffit de cliquer sur Option de la fenétre classe color mapping - Save
changes.

Save Changes

Changer les couleurs des classes en cliquant sur V et en choisissant une couleur de votre
choix

Reset Color Mapping

<ol nu [Cyan] 340 points
cuturs [Magents] 1001 points
forét 3 [Maroon] 580 points
cuture 1 [Sea Green] 629 poirts
<ol nu 1 [Purple] 614 poirts

Class Name

Unclassified

e _sco | I |
K 1 DIF s

Red

2l ] e

Green

Al 2p s

Blue

b. Regrouper ou fusionner des classes

Objectif : Faciliter la lecture de la carte en diminuant le nombre de classes et en se basant sur la connaissance du Terrain.



File Basic Tools [Classification | Transform _Filter _Spectral Map Vector Topographic Radar Window Help

Supenvised »
Unsupervised »
i ' Menu : sur la fenétre ENVI > Post classification>
Create Class Image from ROls Combines Classes
Post Classification » Assign Class Colors.
Rule Classifier

Class Statistics
Change Detection Statistics

Confusion Matrix »
ROC Curves »
Generate Random Sample 3

Majority/Minority Analysis
Clump Classes

Sieve Classes

Combine Classes

Overlay Classes

Buffer Zone Image

Segmentation Image

Classification to Vector

7] Combine Classes Input File. =)

Select Input File: Fils Information:
2 [Fie: C:\Users\llham\Desktop'répétition rap'class S
découpage Dims: 2665x 1885x 1 [BSQ]
Size: [Byte] 180,846,900 bytes.
File Typs : ENVI Classfiication
|Sensor Type: Unknown
Byte Order : Host (intel)

Proecion UTH. Zone 30 Noth Choisissez la derni¢re image correspondant a la classification

Datum - WGS-84 oy
Wavelength : None supervisee.
Upper Left Comer: 1204,261
Description: Maximum Likelihood
(Classfication Result [Thu Aug 04
103:44:43 2011]

[ spatial Subset [[Ful Soene Validez par OK

[ 0% | came [ =i | cpen]

La fenétre Combine Classes Parameters

%] Combine Classes Parameters | ||

Pour fusionner des classes il faut choisir une classe en entrée « Select Input
lass » a laquelle sera ajoutée une deuxiéme classe. Dans cet exemple, on
cherche a fusionner la classe Eau 2 2 la classe Eau 1 et d’avoir a la fin une seule
classe nommée Eaul

Select Input Class Select Output Class

[fr&t TRlal 2R4 ninte
4 3

Input Class Ieau 2 [Green] 159 points

Ot e T P s Dans la fenétre output class, il faut choisir Eau 1 comme classe finale

Add Combination
Combined Classes \

Pour valider le Combine Class cliquez sur Add Combination

OK | Cancsl

Apreés avoir terminé toutes les classes valider par OK et sauvegarder.

T oo

File Basic Tools _Cla: Window _Help

] #2 Bond Tcombine cass

File Overlay Enhance Tools

X))

#2 Zoom [4x]

o
L
a1

F |




10. Vectorisation d’'une classification
Objectif:

Faire passer la classification du mode raster au mode vecteur afin de I’intégrer plus facilement a un SIG

Hlenvial

File Basic Tools Classification Transform _Filter Spectral Map [Vector| Topographic Radar Window Help

Open Vector File Menu:
.

Create New Vector Layer v

Create World Boundaries

Dans la fenétre de ENVI | cliquez sur vector —=>
Raster to vector > load selection new view

Available Vectors List

Raster to Vector

Classification to Vector SeleCted
Rasterize Point Data
Convert Contours to DEM
Convert ROl to DXF
Convert ANN to DXF
Convert EVF to DXF
m Raster Tc Vector Parameters. &J
Select Classes to Vectorize
Unclassified
eau 1[Red] 643 points
eau 2 [Green] 159 points
orét | Daints
furé'lZI ellow] 243 points R . R , . .
wraloenl shoonts Sur la fenétre qui apparait Raster To Vector Parameters, Sélectionnez une classe de votre choix,
EJFL,@:?:ES“;%”%%;EFEQ”;*DM mémorisez et puis validez par OK pour lancer la vectorisation.
sol nu urple; points

Number of items selected: |1

Selsct All tms | Clear Al kems
Output [Singls Layer m

Output Resuttto % File ¢ Memory

Enter Output Filename [.evf] Choose

|C:-Users \llham'.Desktop\répétition rap‘forét vector.

OK | Cancel

] Available Vectors List B e =5

File Options

Available Vector Layers:

Pour visualiser la couche vectorielle, choisissez dans la fenétre Available Vectors
List qui apparait le fichier RTV et validez en cliquant sur Load Selected.

Mame: RTV {combine class)

File: C:M\Users\llham"Deskiop répetition rapforét vector.er
Size: 2 431,388 bytes

Records: 9,017 [121,825 nodes]

Proj : UTM, Zone 30 North [Meters]

Datum: WGS-84

Attributes: Yes

Select All Layers | Deselect All Layers ‘

| Load Selected | Remove Selected ||

@ Vector Window #1 : Cursorm':'

File Mede Edit Options Help

Dans cet exemple, la couche vectorielle correspond a celle
la classe forét de la classification.

Mode: Cursor Guery
Active: "RTV (combine class)"




ﬁ Vector Window #1 : Cumw_J
F

Mode Edit Options  Help

Open Vector File...

Create New Layer...

Save Layers te Template...

Restore Layers from Template...

Export Active Layer to ROLs...

Export Active Layer to Shapefile...
Calculate Buffer Zone..,
Save Plot As
Print...

Cancel

Mode: Cursor Query
Active: "RTV {combine class)"

7] Output EVF Layer to Shapefile Lﬂ_hj

|E\-"F Layer: RTV (combine class)

Cument Output Directory:
CUsershlham'Desktop'répétition rap

Enter Cutput Filename [shp] Choose

|C MUserstlham'Desktop répétition rap ‘export vectc

oK Cancel

Le fichier vectoriel au format EVF peut étre exporté au format shp.
Cliquez sur File > Export Active Layer to Shapefile..

Le fichier va étre enregistré sous format Shp.

Enregistrez le fichier en cliquant sur Choose et validez par OK.
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